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Disclaimer

The results produced by use of this Benefit-Cost Analysis Program are neither
conclusive evidence that a proposed project is cost-effective, nor a guarantee that a
project is eligible for any government grant for whatever purpose.

The software program accompanying this manual was developed under contract with
the Federal Emergency Management Agency (FEMA).

FEMA and the software developers have checked this version carefully and have
verified the results by comparison to earlier versions to assure that the program is
fully operable.  However, users of this manual and/or the accompanying software
assume responsibility for the results of calculations.

Please document and report any problems discovered with this version of the
Benefit-Cost User's guide or software to FEMA by email at paul.tertell@fema.gov.
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1 Introduction

1.1 Scope of the Manual and Software
This manual and accompanying software were prepared for the use of the Federal
Emergency Management Agency (FEMA) in conducting benefit-cost analyses of
hazard mitigation projects for tornado and hurricane shelters.

1.2 Hazard Mitigation and Benefit Cost Analysis
Hazard mitigation projects are specifically aimed at reducing or eliminating future
damages.  Although hazard mitigation projects may sometimes be implemented in
conjunction with the repair of damages from a disaster, the focus of hazard
mitigation projects is on strengthening or improving buildings to enhance their
ability to withstand the impacts of future disasters.

Benefit-cost analysis compares the "benefits" and "costs" of a proposed hazard
mitigation project.  For tornado and hurricane shelters, the only benefits considered
are avoided future deaths and injuries in the shelter that are expected to occur as a
result of the mitigation project.  In other words, benefits are the reduction in
expected future deaths and injuries (i.e., the difference in expected future deaths and
injuries before and after the mitigation project).  These benefits are monetized using
Federal guidelines for loss of life and injury.  The costs considered are those
necessary to implement and maintain the specific mitigation project under
evaluation.

Costs are generally well determined for specific projects for which engineering
design studies have been completed.  Benefits, however, must be estimated
probabilistically because they depend on the improved performance of the building
or facility to future tornado and hurricane events, the timing and severity of which
are random variables.

The "benefits" calculated by the program are expected annual benefits, which are
estimated over the useful lifetime of the mitigation project.  To account for the time
value of money, a net present value calculation must be performed.  This calculation
is done automatically in the program, using the discount rate and project useful
lifetime entered by the user.  Results of benefit-cost calculations are presented two
ways:  first, the benefit-cost ratio (benefits divided by costs) and second, the net
benefits (benefits minus costs).

To estimate future damages (and the benefits of avoiding them), the probabilities of
tornado and hurricane future events must be considered.  The probabilities of future
events profoundly affect whether or not a proposed hazard mitigation project is cost
effective.

Mitigation may not be cost-effective even though a particular facility experienced
great damage in a past event due to an event with a low probability of occurrence
(i.e., a 500- or 1000-year event).   Conversely, mitigation may be cost effective even
though the particular facility experienced little or no damage in a past event, due to a
higher probability of occurrence.
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Each proposed hazard mitigation project must be evaluated on its own merits to
compare the benefits and costs of a specific project.  There are no "rules of thumb" to
identify cost-effective projects because the costs and benefits of each project are
different.  The benefits of a particular project may vary markedly depending on the
occupancy of a facility, the probabilities of future wind events, and the effectiveness
of the mitigation measure in avoiding future damages.

The Benefit-Cost analysis software for tornado and hurricane shelters only accounts
for avoided deaths and injuries to shelter occupants.  The software does not consider
benefits from reduced building or contents damage or reduced cost for evacuation
and relocation. The software was developed on the assumption that the shelter’s pre-
mitigation (current) occupancy levels for tornadoes and hurricanes events will be the
same as the post-mitigation occupancy levels.  The presence of mitigation measures
for an existing shelter will not increase the number of occupants in a shelter, but will
increase the protection to the existing occupants.

1.3 Overview of Manual
This User’s Guide details the use and implementation of the Benefit-Cost Analysis
software for Tornado and Hurricane Shelters.

Chapter 2 Getting Started describes the hardware and software requirements and
model installation.

Chapter 3 Program Basics details the basic use, navigation, and commands for the
model.

Chapter 4 Tutorial builds step-by-step a mitigation project file using the model and
will show how reports can be generated from completed project files.

Chapter 5 Using the Program provides information about data sources and
calculation methods and assumptions.
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2  Getting Started

2.1 Hardware and Software Requirements
The Benefit-Cost Analysis Model for Tornado and Hurricane Shelters is a stand-
alone software application.  The application requires

• IBM-compatible computer (PC) with Pentium 90MHz or faster
microprocessor.

• VGA 1024 × 768 or higher resolution screen supported by Microsoft
Windows.

• 24MB RAM for Windows 95 or later, 32MB for Windows NT.

• Hard drive with at least 50 MB of free disk space.

• CD-ROM drive.

• Microsoft Windows 95 or later or Microsoft Windows NT 3.51 or later

• Adobe Acrobat Reader 3.0 or later.  The CD contains software to install
Acrobat Reader on several platforms.  Alternatively, the software can be
downloaded from www.adobe.com.

2.2 Software Installation
It is recommended to close all other applications before installing the software.  For
NT users, be sure you have software installation privileges for your computer or
have your system administrator install the software.

1. From Windows, run Setup.exe from the CD-ROM.  One way to do this is to use
Window Explorer to navigate to the CD-ROM drive and double-clicking on the
Setup.exe file.  Also, the Run command under the Start button can be used to
type d:/Setup.exe, where d: should be substituted by the actual letter for the CD-
ROM drive.

2. The setup program will initially copy some of the necessary files and check your
system configuration.  Depending on the configuration, the installation program
may ask you if you want to update these files.  In this case you will need to
restart your computer and run Setup.exe again after the machine reboots.  After
this step has been completed, you will be prompted to start the software
installation by clicking on the OK button.  You can also cancel the installation
program by clicking on the Exit button.

3. If you clicked OK, the next screen will contain the options to Exit, to change the
installation directory, and to install the software to the specified directory.

By clicking the Change Directory button, you will have the option to change the
directory where the software will be installed.  The selected hard drive should
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have at least 50 Mb of free space.  If you type the name of a folder that does not
exist, you will be asked if you want this folder to be created.

After the installation directory has been set, click the button with the computer
and disk graphic to start the software installation.  The program will ask you to
choose a name for the program group under which the model will reside.  The
installation software will then proceed to copy to your hard drive all of the
required files.  A status window will show the progress and the files being
installed.

During the installation process, you may be prompted about whether to
overwrite an existing file with a new file from the installation program.  The
typical situation is when the setup program detects a dll file with the same name
as the one about to be installed.  In many cases, the file being written by the
installation program is a more recent version of the dll in the computer and
could replace the existing file.  If you are unsure, you may skip overwriting the
file; however, there is a chance that the benefit-cost software may not operate
properly.

The install program will copy files to the specified installation directory and the
Windows system, will update the registry, and will add a new item under the
Windows taskbar Start button, Programs menu: Tornado and Hurricane Shelter
Mitigation.  This item contains the following:

Benefit Cost Model Starts the model

Benefit Cost Model Help Opens the model’s help file

User’s Guide Opens the pdf document containing this User’s Guide.

Evaluation Checklists Opens a pdf document containing the wind hazard
evaluation checklist (described in FEMA Publication
361 Design and Construction Guidance for Community
Shelters)

The User’s Guide and Evaluation Checklists are copied to a folder labeled
Tornado & Hurricane BC Model, under the destination selected for installation
of the program.  These files can also be found in the installation CD.

4. After all of the files have been copied and the registry updated, the installation
program will display a window that indicates that the software installed
correctly.  Click the OK button and the installation program will close.  Before
running the model for the first time, be sure to restart your computer.

After the software is installed a shortcut can be created on the desktop by
clicking on the Windows Start button, Tornado and Hurricane Mitigation and
right-clicking on Benefit Cost Model and dragging it to the desktop.



GETTING STARTED             CHAPTER 2

 BENEFIT-COST ANALYSIS MODEL 2-3

2.3 Uninstalling the Software
The install program automatically creates an uninstall procedure for the software.  It
will delete all files and directories created by the install program.

1. In the Start button, select the Settings and then Control Panel.

2. In the Control Panel window, double-click the Add/Remove Programs icon.

3. In the Add/Remove Programs window, under the Install/Uninstall tab, select
from the list the Tornado and Hurricane Benefit Cost Model item and click the
Add/Remove button.

4. The install procedure will remove all files and directories installed by the install
program.  It will also remove the Programs menu item for the software.  You
may be prompted about removing shared files.  Usually you do not uninstall
shared files, since other programs may require those files.  You may also be
notified if there was a problems deleting certain files or directories.

5. A window will indicate when the software has been uninstalled but it is possible
that some items could not be removed.  It is recommended that you complete the
uninstall by manually deleting the folder containing the files.  Be sure to restart
the machine before attempting to reinstall the software.
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3 Program Basics

This chapter will provide an overview of the screens, menus, and navigation buttons
used in the Model.  Chapter 4 will provide a tutorial for using the Model to create a
tornado and hurricane shelter mitigation project file.

To start the model, click the Windows Taskbar Start button.  Select Programs and
then Tornado and Hurricane Shelter Mitigation. Finally, select Benefit Cost Model.

After starting the program, the opening screen will appear:

This screen allows the user to start a new project or open an existing project.  The
next section describes the program screens that allow operation of the program.

3.1 Program Screens
This section provides an overview of the main program screens, their functions, and
the data required.  Chapter 5 provides details about gathering the information
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required for all program screens.  Throughout the application, all fields are required
except those with blue labels.

3.1.1 Project Descriptive Information

Once the user has selected a new project or an existing project on the opening screen,
the Project Descriptive Information screen will appear.

The Project Descriptive Information screen asks for basic information about the
shelter.  The most important item in this screen is the selection of a state and county.
The program covers all 50 states and the District of Columbia, Puerto Rico, the
Virgin Islands, American Samoa, and Guam.  The model only requires that the user
select a state and a county.

Along the top of the screen there is a menu that controls project files, report
generation, and navigation.  Along the bottom are the navigation buttons.  Section
3.2 presents details about the menus and navigation buttons.  Dimmed navigation
buttons indicate the screen being displayed.  The Benefit Cost Analysis button and
menu will only become active when all of the required data has been entered.  Menu
items that are not active also appear dimmed.
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3.1.2 Building Information

Once the user has entered the Project Descriptive Information, a navigation button or
menu item will then load the Building Information screen.

The Building Information screen asks for information about the shelter, dimensions
and construction type, and the occupancy of the shelter during tornado and
hurricanes.  All fields on this screen must have a value entered.

The building length and width are used to estimate the exposure to tornadoes.  The
shelter area corresponds to that section of the building retrofitted to withstand high
winds.  This area may be less than or equal to the building footprint area but cannot
exceed it.  Exposure computations are described in Chapter 5.

The shelter construction can be any of five standard types and a general type:

• reinforced and precast concrete
• reinforced masonry
• unreinforced masonry
• steel
• wood
• user defined
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Damage functions for death and injury have been provided as defaults for these
construction types.  The default values are listed in Chapter 5.  The user must
carefully examine these damage functions to ensure that they represent conditions in
the structure being analyzed.  A sixth category labeled User Defined has been
provided for buildings that do not fall into any of the standard types.  The user must
supply the damage functions when this type is selected.

The default damage curves also depend on the surface area of the building envelope
covered by windows.  If the windows account for more than 7 percent of the surface
area, the corresponding check box should be cleared.

Usually, hurricane occupancy can be predicted based on the maximum capacity of
the shelter because hurricanes can be forecast well in advance for people to travel to
the shelter.  These people are assumed to remain in the shelter for the duration of the
hurricane.  In non-hurricane regions, the hurricane occupancy should always be set
to zero, since the shelter will only be used against tornado hazards.

The unpredictability of tornadoes makes it likely that the people in the building at the
time the tornado occurs will be the ones to head for the shelter.  Therefore, the
shelter occupancy is equal to the building occupancy, which may vary hourly.

The Occupancy Check status box indicates whether the hurricane and tornado
occupancy exceeds shelter area standards of 5 square feet per person during a
tornado and 10 square feet per person during a hurricane.

3.1.3 Tornado Hazard Information

After the building information has been entered, the user can navigate to the Tornado
Hazard Information screen shown on the next page.

For the program to calculate the probability of tornado occurrence in the selected
region, the database must have a sufficient number of past tornadoes.  Because
tornadoes are infrequent events, it is unlikely that a single county will have
experienced a sufficient number of tornadoes for meaningful statistics.  Therefore,
the sample area must typically be comprised of several counties around the target
county.

The Tornado Hazard Information screen allows the user to select a group of counties
using three different methods as explained below.  The target county is shown in
green and is always part of the sample area.  Other counties in the statistical sample
area are shown in red.  The user can right-click on any county to view its name.  The
status box below the selection options indicates whether the group of counties has a
sufficient number of past tornadoes to compute tornado statistics.
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Region Around County allows the user to select a given radius around the target
county.  All counties within that radius will be used as the sample area.  Entire State
selects all of the counties in the state of interest.  User Selected Counties allows the
user to select individual counties, and can also be used to modify areas selected with
the other two methods.  The sample area cannot be modified by clicking on
individual counties in this screen.

When the Edit Counties button corresponding to the User Selected Counties option is
pressed, the following screen appears.
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The user can click on individual counties to add or remove them from the statistical
sample area.  Clicking on white counties adds them to the sample area.  Clicking on
red counties removes them from the sample area.

The changes are confirmed or ignored using the three buttons to the right.  Done
returns to the Tornado Hazard Information screen with the new county selection.
Reset clears all counties except the target county.  Cancel ignores changes and
returns to the Tornado Hazard Information screen.

Like the Tornado Hazard Information screen, the User Selected Counties screen also
contains a status box that indicates when a sufficient number of counties has been
selected.
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3.1.4 Mitigation Project Information

The Mitigation Project Information screen asks for the costs associated with the
mitigation project, along with the project lifetime and discount rate.  The user also
enters monetary values for injuries and deaths, since the program determines benefits
based on reduction of injuries and deaths.  Default values are provided as explained
in Chapter 5.

The pre-mitigation default values are based on the construction type selected on the
Building Information screen.  The mitigation effectiveness indicates what percent of
pre-mitigation injuries and deaths will be avoided by implementing the proposed
mitigation.  Default values for mitigation effectiveness are based on the Design Wind
Speed selected from the provided drop-down list.  Figure 2-2 in the FEMA
publication 361 Design and Construction Guidance for Community Shelters contains
a map with the design wind speeds for the U.S.  This map is also on page 16 of the
Evaluation Checklists pdf file that was installed with the model (see Section 2.2 for
the location of this file).  The program uses the effectiveness to calculate post-
mitigation injuries and deaths.  The user can override any of the defaults by entering
other values in the corresponding column.
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3.1.5 Benefit Cost Analysis

Once all of the required information has been entered, both the navigation menu and
button that invoke the Benefit Cost Analysis screen become active.

This screen requires no user input and displays the results of the benefit-cost
analysis.  The screen shows the expected annual benefits of the mitigation for
tornadoes and hurricanes.  Annualized project costs are calculated, based on the
project lifetime and discount rate.  The expected annual net benefits are the
difference between the benefits and the costs; a positive value indicates a cost-
effective project.  A Benefit Cost Ratio of 1.0 or greater is also indicative of cost-
effectiveness.  The expected number of deaths and injuries avoided over the project
lifetime, due to the proposed mitigation, are also shown.
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3.1.6 Short Report Print Preview

After a benefit-cost analysis has been performed, the Print Preview and Print items
in the File menu become active.  When Print Preview, Short Report is chosen, the
following screen is displayed.

The short report is a one page summary of the inputs and results of the benefit-cost
analysis.  The print preview screen allows the user to view and print the report.

The tools associated with this screen will be explained in the next section.
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3.1.7 Long Report Print Preview

When Print Preview, Long Report is chosen, the following screen is displayed.

The long report is a seven-page report giving detailed information about the program
input data, the hazard statistics, and the results of the benefit-cost analysis.  The print
preview screen allows the user to view and print the report.
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The toolbar along the top of the print preview screen allows the user to print the
report, view the report at different magnifications levels, and navigate through the
report pages.

From left to right, the first icon in the toolbar controls a table of contents (which is
not used).  The second icon, with the printer graphic and the word “Print…”,
activates the print command, which displays a screen where the user can select the
printing options.  The print screen also allows access to printer setup commands.

The next three icons control the magnification of the print preview.  The + and –
magnifying glass icons zoom in and out on the current page of the report.  The drop
box with percentages also controls the magnification of the current page.

The final five icons relate to navigation through a report and are only active for the
long report.  The page up and down arrow icons will cause the screen to go to the
previous or next page in the report.  The window next to these icons indicates the
current page number and the total page number.  Finally, the back and next buttons
can also be used to navigate through the report pages.

The Print Preview screen can manually be resized or moved by clicking with the
mouse on the screen border and dragging to the desired size or location.  The screen
can be closed by clicking on the X icon on the upper right corner of the screen.

In addition, the screen can be resized, moved, or closed using the Window menu,
which is activated by clicking on the tornado icon in the upper left corner of the
screen (before the screen title).  The Window menu is available on all screens in the
model.

3.2 Commands and Procedures
This section details the menu items and navigation buttons included in the program.

3.2.1 File Menu

The File menu controls the files used to store the mitigation project information,
allows the creation and printing of reports, and allows the user to exit the program.
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New creates a new project file.  After prompting the user to save the current project,
all program screens will be cleared for the new project.

Open loads an existing project file.  The program stores projects with the .tor
extension.  After prompting the user to save the current project, a browse window
will open that allows the user to load a project file from any directory.  The selected
file will load and all screens will be updated with the selected file’s information.

Save saves the current project file.  If the file has previously been saved, Save will
use the existing file name.  If the file has not been saved before, the user will be
prompted for a file name.

Save As prompts the user for a file name for the current project.

Print Preview allows the user to preview either the short or long format reports
generated by the program after a benefit cost analysis has been performed.  The
reports can be printed from the preview window.  The toolbar and Window menus in
the print preview screens are described elsewhere in this document.

Print allows the user to print either the short or long format reports generated by the
program after a benefit-cost analysis has been performed.

Exit will close the program after prompting the user to save the current project.
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3.2.2 Edit Menu

The Edit menu allows the user to copy and paste text between the clipboard and the
program inputs.

Cut deletes selected text from its current location and copies it to the clipboard.

Copy places selected text in the clipboard without deleting it from its location.

Paste places text currently in the clipboard into the selected location.



CHAPTER 3  USER’S GUIDE

 3-14 FEDERAL EMERGENCY MANAGEMENT AGENCY

3.2.3 Input Menu

The Input menu provides navigation between the four input information screens
described above.  Selecting one of the four menu items switches the application to
the corresponding screen.
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3.2.4 BC Analysis Menu

The BC Analysis menu contains one item only that provides navigation to the
Benefit-Cost Analysis screen.
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3.2.5 Help Menu

The Help menu loads the Help file for the program.  Throughout the program, the F1
key loads topic-specific help.
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3.2.6 Navigation Buttons

The Navigation Buttons are an alternate way to move between screens.  The button
for the active screen is dimmed.  Clicking on any of the buttons switches to the
corresponding screen.  The Benefit Cost Analysis button is dimmed until all of the
required information has been entered.
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4 Tutorial
This chapter will provide step-by-step details for entering project information,
performing a benefit-cost analysis, saving and retrieving a project file, and
previewing and printing reports.

4.1 Creating a New Project
To start, click the Windows Taskbar Start Button.  Select Programs and then
Tornado and Hurricane Shelter Mitigation.  Finally, select Benefit Cost Model.

Select New Project from the opening screen and click OK.
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4.1.1 Project Descriptive Information

After the Project Descriptive Information screen is displayed, enter the information
shown below.  Use the mouse or tab key to navigate through the input fields.

Building Name Lanier Elementary School
Address Thompson Bridge Road
City Gainsville
State Georgia (Use drop-down list)
County Hall (Use drop-down list)
Disaster Number NA
Project Number 1
Scenario Run ID 1
Analyst FEMA

Note that the county dropdown box will not contain any choices unless a state has
been selected.  The software will not allow switching to another screen unless a state
and county have been selected.

The completed screen should look like the following:

Click on the Building Information button to go to the Building Information screen.
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4.1.2 Building Information

Enter the information shown below into the Building Information screen.  The mouse
or tab key will navigate through the input fields.  As you enter the data, you will
notice that the message in the Occupancy Check status box will change.

Building Longest Length 500 ft
Building Longest Width 200 ft
Shelter Area 5000 ft2

Shelter Construction Type Reinforced & Precast Concrete (Use drop-down list)
Checkbox for “Building has minimal
window area (less than 7% of wall area)”

Checked

Hurricane Shelter Occupancy 100 people
Tornado Shelter Occupancy 0 for 12 am through 6 am

200 people for 7 am
581 people for 8 am through 1 pm
200 people for 2 pm through 4 pm
20 people for 5 pm through 6 pm
100 people for 7 pm through 9 pm
0 for 10 pm through 11 pm

Time Zone Automatically chosen by program as Eastern ST
Checkbox for Daylight Savings Automatically checked by the program

The completed screen should look like the following:
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The status box will warn the user when the occupancy exceeds 5 ft2/person for
tornado shelters or 10 ft2/person for hurricane shelters.

Click on the Tornado Hazard button to go to the Tornado Hazard Information
screen.

4.1.3 Tornado Hazard Information

When you first enter this screen, only Hall County will be selected (shown in green)
and none of the county selection options will be active.  The computer will beep
whenever the selected counties do not have a sufficient number of tornadoes to
compute hazard probabilities.
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Click on Region Around County.  A slider bar and text box will appear to select a
region around Hall County from which tornado statistics will be derived.  In the
majority of cases, one county alone has not experienced enough tornadoes to
calculate meaningful statistics.

Click on the slider bar once or drag it to advance the radius from 0 to 50 miles.  You
can also type the radius value in the text box and hit Enter.  After this is done, you
will need to wait a few moments while the program queries the national tornado
database determines if the selected counties have sufficient tornado occurrences for
statistical analysis.  The status box will read “Calculating” until the selection and
calculation are complete.
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The screen should look like the figure shown below.  Notice that the newly selected
counties are in red, while Hall County remains green.  Also notice that the map scale
resets to show Georgia, South Carolina, and North Carolina, since the selected
counties fall within these states.

Clicking User Selected Counties allows manual addition or deletion of counties to
the statistical sample area.  This option is seldom used.  Unless there are site-specific
conditions that justify modifying the selection, the user should let the software select
counties according to a specified radius.  If modified, the selection should be such
that the counties in the sample area are all contiguous.  Chapter 5 provides additional
information on when the manual option should be invoked.
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After clicking User Selected Counties, the Edit Counties button becomes visible as
shown in the next figure.
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For this tutorial, assume that you only want to use counties in Georgia.  To remove
the counties in other states, click the Edit Counties button.  The User Selected
Counties screen should appear as shown below.  This screen allows you to add or
remove individual counties.

Using the mouse, left click on the red counties that are not in Georgia.  As you click
on these counties, they will change from red to white and the status window will
show whether sufficient tornadoes remain in the sample area to compute statistics.
Clicking on white counties will add them to the selected region.
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When you have removed all counties not in Georgia, the view will zoom in to only
Georgia and look like the screen shown below.

To keep these selected counties, click the Done button to return to the Tornado
Hazard Information screen.  The Reset button deselects all counties except Hall
County.  The Cancel button closes this window and returns to the Tornado Hazard
Information screen with the selection unchanged.
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When you return to the Tornado Hazard Information screen, the map will be
identical to the one you created on the User Selected Counties screen and should
look like the screen shown below.

Now that you have selected your counties for tornado statistics, click the Mitigation
Project Information button to go to that screen. A popup window with a progress bar
indicates that tornado statistics are being extracted from the tornado database.
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4.1.4 Mitigation Project Information

In the Mitigation Project Information screen, enter the following information:

Mitigation Project Description Strengthened Hallway
Project Cost $225,793
Maintenance Cost $0 (Default)
Project Lifetime 30 years
Discount Rate 7 % (Default)
Injury Cost $12,500 / injury (Default)
Death Cost $2,200,000 / death (Default)
Design Wind Speed 200 mph
User-Defined Pre-Mitigation
Injury and Death Curves

Enter 0 only in the first 3 wind ranges for
injury and death.

Default values will be used for all other pre-mitigation and mitigation effectiveness
boxes that are left blank.  This input assumes that the building withstands a wind
speed of up to 118 mph in its current state; therefore, no deaths or injuries are
expected.

After the data has been entered, the screen should look like the figure below.
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This screen contains several default values.  When you enter a value for the Project
Lifetime, the Benefit Cost Analysis button and menu become active.  This indicates
that all of the data necessary to perform a benefit-cost analysis have been entered.
Click the Benefit Cost Analysis button to perform the benefit cost analysis.

4.1.5 Benefit Cost Analysis Results

After a brief pause for calculation, the Benefit Cost Analysis screen will show the
results of the analysis.  For the project data entered, the project is cost-effective, with
a Benefit Cost Ratio of 7.17 and an Expected Annual Net Benefit of $112,291.
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To save the project just created, click on the File menu and select Save to open the
form shown below.

Navigate to the directory of your choice and in the File name box, enter a name for
the file.  The program will save the project as <your_file_name>.tor.

You have now successfully entered and saved a tornado and hurricane shelter
project!

To exit the program, select the File menu and Exit.  You will always be prompted to
save your current project.  Select No, since you just saved your project.
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4.2 Editing an Existing Project
The second half of this tutorial covers opening existing project files and producing
project reports.

4.2.1 Opening an Existing Project

There are two ways to open an existing file.  When you first start the program, you
can selected the Existing File option.  Also, if you are already in the program, you
can use the File menu and Open to open an existing file.  Using either method, you
should have a screen like the following:

Open gaschool.tor, a sample project file installed with the program.  You can only
have one project open at a time.



TUTORIAL             CHAPTER 4

 BENEFIT-COST ANALYSIS MODEL 4-15

4.2.2 Preview Long Report

After the file has been loaded, you will notice that the Benefit Cost Analysis button
and menu item are active.  As mentioned before, this indicates that the project has
sufficient information to perform a benefit costs analysis.  This also indicates that
Print and Print Preview in the File menu are active.  In the File menu, select Print
Preview, Long Report.  The following screen will appear:
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The long report is a seven-page document that gives details on the input data, hazard
statistics, and benefit cost results.  Pages 1 through 4 list the input data entered in the
Project Descriptive Information, Building Information, Tornado Hazard Information
and Mitigation Project Information screens.  Page 5 shows a summary of the tornado
statistics associated with the project and page 6 summarizes the extreme wind
statistics.  Finally, page 7 shows the benefit-cost analysis information and remarks
on the options chosen by the user.  These remarks DO NOT indicate that an error
was made, only that the project must be carefully reviewed.

To zoom in or out on the current page, use the + and – magnifying glass icons or the
drop-down box with the percent zoom.  To scroll through the pages, use the up and
down arrow page icons.  Back and Forward become active after you have scrolled
through several pages.

Once you have previewed the report, use the print icon to send the file to the printer.
Depending on your printer, you should see a screen similar to the following:

After you click OK to print the report, you will be returned to the Print Preview
screen.  To exit the Print Preview screen, click on the icon in the upper left corner
and select Close or click the X in the upper right corner of the screen.
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4.2.3 Print Short Report

There are two methods to print the long and short reports.  The previous section
described the first method that uses Print in the Print Preview screen.  To use the
second method, go to the File menu and select Print and Short Report.  You should
see a screen similar to the following:

Notice that the range for pages to print is dimmed since the short report is only one
page long.  Click OK to print this report.  You will then be returned to your original
screen.
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5 Using the Program
This chapter discusses two topics: data sources for some of the inputs required
by the model and an overview of the methods and assumptions used for
calculation of benefits and costs.

5.1 Data Sources

5.1.1 Project Descriptive Information

The data required for the Project Descriptive Information screen is mainly for
project documentation.

Project Descriptive Information

Input Data Source

Building Name Descriptor to identify building.

Address Project location

City Project location

State Project location (required)

County Project location (required)

Disaster Number Assigned by FEMA for declared disasters, available at FEMA’s
web page (www.fema.gov)

Project Number Assigned by FEMA, state, or municipality for project
management purposes

Scenario Run ID Assigned by analyst for comparison of alternatives (optional)

Analyst Name of person or organization performing analysis
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5.1.2 Building Information

The data required for the Building Information screen come from design
information about the proposed project.

Building Information (all fields required)

Input Data Source

Building Longest Length Building footprint

Building Longest Width Building footprint

Shelter Area Project design data; should not exceed
building footprint area

Shelter Construction Type &
Window Area

Project design data

Hurricane Shelter Occupancy Project design information, should not
cause less than 10 ft2/person

Hourly Tornado Shelter Occupancy Project design information, should not
cause less than 5 ft2/person

Time Zone Project location, default based on
selected county

Daylight Savings Project location, default based on
selected county

The building length and width should be the longest dimensions of the sides of
the entire building where a shelter is located, even if the shelter is located in
only part of the building (see Section 5.2.4.1.1. for more information).  These
dimensions define the “target area” for tornadoes.  The shelter area is only that
area of the building that is used during an emergency.

The shelter construction categories are:

• Reinforced & Precast Concrete
• Reinforced Masonry
• Unreinforced Masonry
• Steel
• Wood
• User-Defined

Window coverage categories are:

• Less than 7% of wall area
• Greater than 7% of wall area
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Each combination of construction and window categories, with the exception
of the User-Defined category, are associated with a corresponding pre-
mitigation injury and death damage curve, which are given as defaults on the
Mitigation Project Information screen.

Usually, hurricane occupancy can be predicted based on the maximum capacity
of the shelter because hurricanes can be forecast well in advance for people to
travel to the shelter.  These people are assumed to remain in the shelter for the
duration of the hurricane.  The unpredictability of tornadoes makes it likely that
the people in the building at the time the tornado occurs will be the ones to
head for the shelter.  Therefore, the shelter occupancy at any given time in the
day is equal to the building occupancy.  The occupancy input should be based
on the project design of the shelter, where occupants during a hurricane should
have at least 10 square feet and occupants during a tornado should have at least
5 square feet.  The program automatically adjusts the average hourly
occupancy value if a location observes daylight savings.  For those counties
that contain two time zones or different observances of daylight savings, the
user should adjust the time zone and daylight savings as necessary so that the
occupancy shown is representative of average conditions.  In non-hurricane
regions, the hurricane occupancy should always be set to zero, since the shelter
will only be used against tornado hazards.

5.1.3 Tornado Hazard Information

The program has an extensive database of tornado information for each county
in the U.S collected by the National Atmospheric and Oceanic Administration
(NOAA).  This database is used to compute tornado probability of occurrence.
The user must select a set of counties to calculate the tornado statistics for the
project location.  A status box indicates when a sufficient number of counties
has been chosen to produce meaningful tornado statistics.

The actual selection of counties depends on the scope of the project and the
analyst’s knowledge of tornadoes around the project location.  In most cases,
selecting a region within a given radius around a county will provide a
sufficient tornadoes.  However, for smaller states or for statewide planning
purposes, the entire state of interest may be appropriate.

The User-Selected Counties option should only be used when the analyst has
site-specific information that supports the selection of a specific group of
counties.  For example, tornado occurrence has been shown to depend on relief;
therefore, the user may want to include in the sample only counties with similar
terrain characteristics.  Another situation in which manual modifications may
be needed is when it is politically undesirable to include counties in
neighboring states.

In any case, manual selection of counties should produce a region comprised of
contiguous counties.  The long report lists all of the counties in the statistical
sample region broken down by state.  The user or reviewer can use this list to
verify the continuity of the sample region.
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5.1.4 Mitigation Project Information

The data required for the Mitigation Project Information screen comes from
mitigation project planning and analysis of potential damages in the event of a
hurricane or tornado.

Mitigation Project Information (all fields required except as noted)

Input Data Source

Mitigation Project Description Descriptor for mitigation project (not
required)

Project Cost Capital cost of implementing the project

Maintenance Cost Annual operating and maintenance
expenses

Project Lifetime Expected useful life of the project
(usually 30 to 50 years)

Discount Rate User-selected discount rate.  Federally
funded projects use 7%

Injury Cost Monetized injury damages.  The Federal
Aviation Administration (FAA) uses
$12,500 per major injury

Death Cost Monetized loss-of-life damages.  The
FAA uses $2,200,000 per death

Design Wind Speed From Figure 2-2 in the FEMA
publication 361 Design and Construction
Guidance for Community Shelters and
on page 16 of the Evaluation Checklists

Injury: Pre-Mitigation Evaluation of current building condition.
Default curves are provided for given
building types

Injury: Mitigation Effectiveness Estimated protection provided by
mitigation project.  Default curves are
provided for selected design wind speeds

Injury: Post-Mitigation Calculated based on pre-mitigation and
mitigation effectiveness

Death: Pre-Mitigation Evaluation of current building condition.
Default curves are provided for given
building types

Death: Mitigation Effectiveness Estimated protection provided by
mitigation project.  Default curves are
provided for selected design wind speeds

Death: Post-Mitigation Calculated based on pre-mitigation and
mitigation effectiveness
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The mitigation project description provides general information about the
proposed mitigation project.  The project cost should include all one-time costs
to implement the mitigation project, while the maintenance cost should include
annual costs to insure that the project functions properly.  Both cost figures
should only account for additional costs to construction from implementing the
mitigation project.  For example, if building has been planned to withstand 150
mph winds, but a mitigation project is proposed to strengthen it to 200 mph,
then the costs should only include the additional measures needed to strengthen
the structure.  Often the total construction cost can be prorated by a
construction expert or contractor that is familiar with the additional costs for
strengthening a shelter against stronger winds.

The project lifetime is the useful life of the mitigation project.  The discount
rate is used for present value calculations and has a default value of 7% for
FEMA funded projects.

The injury and death costs assign a dollar value to human injury and death.
The Federal Aviation Administration (FAA) has estimated defaults for major
injury and death of $12,500 and $2,200,000, respectively.

The Design Wind Speed is the 3-second gust wind in miles per hour (mph) that
the FEMA publication 361 Design and Construction Guidance for Community
Shelters recommends for shelters.  Figure 2-2 in this publication provides the
geographic distribution of these values.  This map is also on page 16 of the
Evaluation Checklists file that was installed with the model (see Section 2.2 for
the location of this file).

The last set of information estimates percent injury and death associated with
structural failure at different wind speed ranges.  The pre-mitigation values
have defaults based on the construction type and window coverage selected on
the Building Information screen.  These default values for pre-mitigation must
be adjusted to account for local building codes and standards and the current
condition of the building.  Most communities require structures to be built, at a
minimum, to withstand certain wind levels.  The pre-mitigation default values
do not consider these standards, since they vary through the country, and the
user must enter values consistent with these standards.  For example, a shelter
may have been designed based on a local minimum design wind speed of 100
mph.  In the User-Defined Pre-Mitigation columns for injury and death, zeroes
should be entered for all wind ranges up to and including 100 mph, as shown in
the figure below.
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Similarly, the mitigation effectiveness values should be adjusted if the default
mitigation effectiveness does not fully reflect the actual mitigation design.

Supporting documentation must accompany any analysis that requires these
kinds of adjustments.

The model is intended to analyze the economic feasibility of retrofitting an
existing building to install a shelter capable of withstanding high winds.  This
includes adding a shelter to an existing building.  However, the software can
also be used to evaluate cost-effectiveness of constructing a new building,
where the entire building will be used as a shelter.  In this case, the user needs
to select the User-Defined option in the Shelter Construction Type dropdown
box in the Building Information screen and supply the damage and mitigation
effectiveness curves in the Mitigation Project Information screen.  The loss
data must accurately reflect the injuries and deaths expected in the population
expected to use the shelter. These deaths and injuries must be computed based
on the locations where the targeted population is anticipated to be when the
wind event occurs, if the shelter is not constructed.  The development of these
data is not a trivial task and requires careful examination of site conditions and
consultation with wind engineers, community planners, and emergency
response professionals.
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5.2 Calculation Methods and Assumptions
The methodology used in this software application was based upon available
tornado and wind data and assumptions described in the following sections.

5.2.1 Building Information

Exposure to tornadoes depends on the size of the building and the frequency
and severity of tornado events.  As shown in the next section, in the worst-case
scenario, a tornado has the greatest chance of striking a building if it
approaches the structure perpendicular to its longest dimension.  The model
assumes that this dimension can be approximated as the diagonal resulting
from the longest width and length.

Tornado occurrence varies with the time of day and geographic location.
Therefore, the software calculates hourly tornado probabilities for the statistical
sample region.  It is assumed that during a tornado emergency the shelter
houses all of the people in the building at that time.

The shelter area corresponds to that portion of the building that will serve as
protection during a tornado or hurricane.  Typically, this area is smaller than
the entire building footprint.  It is assumed that tornado emergencies will have
relatively short shelter occupancy times and that 5 ft2 per person is an
acceptable minimum space requirement.  Hurricanes demand longer occupancy
times and the minimum requirement increases to 10 ft2 per person.  The user
should account for additional factors such as wheelchairs and life support
equipment, if needed.

5.2.2 Tornado Hazard Information

The county-based statistics use the tornado database compiled in the NOAA
Storm Prediction Center archives and available at
www.spc.noaa.gov/archive/tornadoes.  The statistics are based on tornado
events that have a recorded length, width, tornado Fujita scale (F-scale), and
time of occurrence.  When the user selects a group of counties, the tornado
events are accumulated for the selected counties to determine if there is
sufficient data available for tornado statistics.

5.2.3 Mitigation Project Information

The default pre-mitigation injury and death damage curves are based on the
construction and window categories selected in the Building Information screen
and shown in the following tables for nine wind speed ranges.  The wind
ranges roughly correspond to specific tornado Fujita scale (FS) and hurricane
Saffir-Simpson Scale (SSS), as shown in the FS / SSS column.  After structural
collapse, the percent injuries and deaths total 100%.
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Pre-Mitigation Damage Curves:

Expected percent death (D) and injury (I) to occupants of buildings with window coverage
greater than 7% of wall area

WIND PARAMETERS BUILDING CONSTRUCTION CATEGORY

D I D I D I D I D I

Wind
Range

Wind
Speed
(mph, 3-
sec. gust)

FS /
SSS

Reinforced
Precast

Concrete

Reinforced
Masonry

Un-
reinforced
Masonry

Steel Wood

1 0 – 40 0 0 0 0 0 0 0 0 0 0

2 45 - 77 F0 0 0.6 0 0.6 0 1 0 1 0 1

3 78 - 118 F1 / C1 0.3 2 0.3 2 0.3 3 0.3 5 1 7

4 119 - 138 F2 / C2 1 10 2 15 15 85 2 10 10 90

5 139 - 163 F2 / C3 3 30 15 85 25 75 5 45 20 80

6 164 - 194 F3 / C4 15 85 25 75 30 70 25 75 25 75

7 195 - 210 F3 / C5 25 75 30 70 30 70 25 75 25 75

8 211 - 262 F4 30 70 30 70 30 70 25 75 25 75

9 263 + F5 30 70 30 70 30 70 25 75 25 75

Values are % of total occupancy

building envelope intact    D + I = 0%

building envelope breached/
no structural collapse

   D + I = 50% (most cases)

structural collapse    D + I = 100% (all cases)
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Pre-Mitigation Damage Curves:

Expected percent death (D) and injury (I) to occupants of buildings
with window coverage equal to or less than 7% of wall area

WIND PARAMETERS BUILDING CONSTRUCTION CATEGORY

D I D I D I D I D I

Wind
Range

Wind
Speed
(mph, 3-
sec. gust)

FS /
SSS

Reinforced
Precast

Concrete

Reinforced
Masonry

Un-
reinforced
Masonry

Steel Wood

1 0 – 40 0 0 0 0 0 0 0 0 0 0

2 45 - 77 F0 0 0.4 0 0.4 0 0.6 0 0.6 0 0.6

3 78 - 118 F1 / C1 0.3 1 0.3 1 0.3 2 0.3 3 0.7 4

4 119 - 138 F2 / C2 0.5 7 1 10 15 85 1 7 10 90

5 139 - 163 F2 / C3 2 20 15 85 25 75 3 30 20 80

6 164 - 194 F3 / C4 15 85 25 75 30 70 25 75 25 75

7 195 - 210 F3 / C5 25 75 30 70 30 70 25 75 25 75

8 211 - 262 F4 30 70 30 70 30 70 25 75 25 75

9 263 + F5 30 70 30 70 30 70 25 75 25 75

Values are % of total shelter occupancy

building envelope intact    D + I = 0%

building envelope breached/
no structural collapse

   D + I = 50% (most cases)

structural collapse    D + I = 100% (all cases)
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The pre-mitigation injury and death default values must be adjusted to account
for the actual condition of the building being retrofitted.  Design information or
engineering inspection results must be used to determine the maximum wind
speed that the building can withstand without causing any injuries and deaths.
Once this threshold has been determined, all of the default values must be
replaced with zeroes in the User-Defined %column of the Mitigation Project
Information Screen to reflect the fact that no damage is expected for speeds
less than this threshold.  Unrealistically high benefit-cost ratios will result if the
user fails to take this fact into account.

For post-mitigation conditions, the default mitigation effectiveness values are
based on the selected mitigation design wind speed.  These values are the same
for injuries and deaths.

The following table shows the default values
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Mitigation Effectiveness:

Expected Reduction of Percentage Death and Injury to Occupants
of Shelters

WIND PARAMETERS DESIGN WIND SPEED (MPH)

Wind
Range

Wind
Speed
(mph, 3-
sec. gust)

FS /
SSS

130

(mph)

160

(mph)

200

(mph)

250

(mph)

1 0 – 40 100 100 100 100

2 45 - 77 F0 100 100 100 100

3 78 - 118 F1 / C1 100 100 100 100

4 119 - 138 F2 / C2 98 100 100 100

5 139 - 163 F2 / C3 85 98 100 100

6 164 - 194 F3 / C4 55 85 100 100

7 195 - 210 F3 / C5 20 55 98 100

8 211 - 262 F4 0 20 85 98

9 263 + F5 0 0 55 85

building envelope intact

building envelope breached/
no structural collapse

structural collapse
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6 Benefit-Cost Analysis
Benefits are calculated as damages avoided because of construction of the
shelter.  Benefits stem from avoided deaths and injuries, monetized according
to the dollar value of loss of life and injury used by the FAA.  Benefits are
computed separately for tornado and hurricane hazards.  Cost calculations are
based on project cost information.  This chapter describes the equations and
assumptions used in these calculations.

Project benefits only reflect avoided shelter injuries and deaths due to the
mitigation project.  Therefore, all benefits are highly dependent on the building
occupancy values and increase in structural resistance.  Both tornado and
hurricane benefits are calculated by determining the difference between pre-
mitigation deaths and injuries and post-mitigation deaths and injuries.  A
general equation for the number of deaths of injuries for a given instance (pre-
or post-mitigation) is:

Number of deaths or injuries = Occupancy × Probability(death or injury)
× Probability(Event)

where Occupancy is entered on the Building Information screen for hurricane
and tornado, Probability(death or injury) is computed from on the tables on the
Project Mitigation Information screen, and Probability(Event) is based on the
probability of a tornado or hurricane event of given severity, which is measured
using the Fujita scale for tornadoes and the wind speed distribution for
hurricanes.

The numbers of deaths or injuries are converted to dollars using FAA values
for loss of life and injuries.

6.1 Tornado Benefits
Tornado hazards have been summarized on a county basis based on data from
the NOAA Storm Prediction Center archives.  The tornado hazard calculation
determines the impact of a given Fujita class tornado AT a given hour, e.g.,
what is the probability of a F3 tornado hitting the building at 9 am EST?  To
determine this probability, the potential hazard area for a building of given
dimensions is first computed.  This calculation is explained using the diagram
shown below.
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b

wf

wf

Possible Paths of a
tornado of class f

Building

In the figure, b is the maximum building dimension that can face the tornado
and wf is the potential path width for a tornado of class f that strikes the
building normal to its broadest dimension.

A tornado of class f will impact a building if its path falls anywhere between
the solid lines.  It is assumed that the building suffers the same damage
regardless of where in the footprint the tornado hits.  Therefore, the exposure
area af for the building will be equal to
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where lf is the path length for a tornado of Fujita class f.  The average annual
potential hazard area for the building caused by tornadoes of class f is equal to
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where fa  is the average annual potential hazard area, fA is the average annual

disturbed area, and fl  is the average annual path length for tornadoes of class f.

The superscript i indicates a class f tornado occurrence; n is the total number of
class f tornadoes in the record and N is the number of years in the record.  This
calculation requires statistics of tornado width and length and must be
performed for each tornado class.

The probability of a building being hit by a tornado of given class is calculated
as the ratio of the average annual potential hazard area to the total area of the
sample region.  The Long Report shows a summary of these calculations.

To account for hourly variations, for each tornado class the hourly distribution
of occurrences is determined, which involves counting all tornadoes of a given
class that occurred at a particular hour and dividing by the total number of
events in the record for that tornado class.  The probability of a given class f
tornado occurring at a given hour is computed by multiplying the hourly
probability for that class (which sums to 100% for an entire day) times the
probability of that class occurring for an entire year.

Once these probabilities are known, the expected annual number of deaths
caused by a tornado of class f can be computed by multiplying the deaths that
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this tornado is likely to cause times its probability of occurrence.  A similar
computation is performed for injuries.  The deaths and injuries that a given
tornado may cause are related to the pre-mitigation condition of the building.
The average number of deaths and injuries can be monetized by multiplying
those figures times the FAA values for loss of life and injury.

This procedure is repeated for all tornado classes and the results added to
obtain the total expected annual dollar value of death and injury caused by
tornadoes of all classes.  The entire calculation is done once more using post-
mitigation conditions.  The difference between these two sets of values gives
the annual benefits associated with the mitigation project.

6.2 Hurricane Benefits
Hurricane hazards have been determined for the U.S., since researchers have
established extreme wind exceedance probability information throughout the
country, which includes hurricane wind data.  In ASCE 7-98, Minimum Design
Loads for Buildings and Other Structures, the 50-year exceedance wind speed
(in mph for 3-second gusts) is given for the U.S. and territories.  This
publication also contains adjustment factors to this 50-year exceedance wind
speed to obtain the speeds for 5-, 10-, 25-, 100-, 200-, and 500-year mean
recurrence intervals (MRI).

To determine the hurricane hazard at a given location, a database of maximum
50-year wind speed for each county was developed from the ASCE 7-98 wind
maps.  Next, adjustment factors for different mean recurrence intervals were fit
to log regression curves to estimate the exceedance probability for any given
wind speed.  When the user selects a county, the probability of each of the nine
wind speed intervals is determined by subtracting the exceedance probabilities
for the two wind speeds that bound that interval.

The Long Report shown in the following figure displays these probabilities for
each wind speed range.
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For maximum MRI wind speeds, the lowest wind speed range probability will
often be 0.0, since the exceedance probability of both the lower and upper
bound of that wind range is equal to 1.0.  This implies that this location will
always have maximum wind speeds greater than this range.

Because the pre-mitigation damage curves relate wind speed to numbers of
deaths and injuries, the wind speed exceedance probability can be used to
determine the probability distribution of deaths and injuries.  Using the FAA
values for loss of life and injury, this distribution can be transformed into the
probability distribution for damages in dollars.  The area under this curve is
equal to the expected annual damages.

This calculation is repeated using the damage curves for post-mitigation
conditions.  The difference between the annual expected damages before and
after mitigation is equal to the benefits.



CHAPTER 6  USER’S GUIDE

 6-6 FEDERAL EMERGENCY MANAGEMENT AGENCY

6.3 Project Costs
To compare costs and benefits on an equivalent basis, all project costs must be
converted into equivalent annual costs.  This is accomplished by using a
standard economic equation that distributes a one-time cost over the project
lifetime based on the discount rate.  When this annualized cost is added to the
maintenance costs, an estimate of the annual costs of the project can be
calculated.

6.4 Benefit-Cost Ratio
With the cost and the benefits known, the two measures of cost-effectiveness
can be calculated.  The expected annual net benefits are the difference between
the benefits and the costs, where a positive value indicates a cost-effective
project.  The Benefit-Cost Ratio is calculated by dividing the annual benefits
by the annual costs, where a value greater than or equal to one indicates a cost-
effective project.


